CS 700: Quantitative Methods &
Experimental Design in Computer Science

Sanjeev Setia
Dept of Computer Science
George Mason University

Logistics

O Grade: 35% project, 25% Homework assignments
20% midterm, 20% take home final

O Slides, assignments, reading material on class web
page http://www.cs.gmu.edu/~setia/cs700/

O Several small assignments related to material
discussed in class
> Not all will be graded, but we will go over solutions in

class

QO Term project
> should involve experimentation (measurement, simulation)
> select a topic in your research area if possible
> apply techniques discussed in this class




Readings

O Textbook

> David Lilja, "Measuring Computer Performance: A
Practitioner's Guide" OR

> Raj Jain, "Art of Computer Systems Performance
Analysis"”

O Class notes, slides
0 Relevant research articles (links on class web site)

O Books on probability and statistics for engineers
(see syllabus)
O More specialized topics
> Cohen "Empirical techniques in AL"
> Crovella et al "Internet Measurement”

Course Topics

O Basic techniques in "experimental” computer
science

> Basic measurement tools and techniques
» Simulation
> Design of experiments

O Quantitative Methods
> Use of statistical techniques in design of experiments
» Use of statistical techniques in comparing alternatives
» Characterizing and interpreting measured data

O Simple analytical modeling

Most examples will be from performance measurement of
computer systems and networks, but techniques are
applicable in all fields of CS




Experimental Science

Scientific Method

1. Identify a problem and form hypothesis
+ Hypothesis must be testable and refutable

2. Design an experiment

3. Conduct the experiment

4. Perform hypothesis testing

¢ Use statistical techniques

What about Computer Science?

Experimental Computer Science

Three definitions (Feitelson, 2006)

O Building of systems, hardware or software
> Counterpart to “theoretical CS"

O Experimentation as a feedback step in engineering
loop

0 Evaluation of computer systems using the
methodologies of the natural sciences, i.e.
rigorous methodologies
> Focus of this class

Feitelson makes the case that there is a place for
observation of the real world, as in the natural
sciences, e.g., analyzing measured network traffic




The Role of Experimentation in CS
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Figure 1: A comparison of the scientific method (on the left) with the role of experimentation in

system design (right).

Schedule

0 Introduction

0 Metrics

O Summarizing Measured Data

0O Measurement Techniques

0O Simulation

O Comparing Alternatives
O Linear Regression Models
0 Design of experiments

Q Interpreting & characterizing measured data
O Analytical Modeling




Course Goals

0O Understand the inherent trade-offs involved in
using simulation, measurement, and analytical
modeling.

O Rigorously compare computer
systems/networks/software/artifacts/... often
in the presence of measurement noise

> Usually compare performance but in many fields of CS,
"quality” of the output is more important than raw
performance, e.g. face recognition software

0 Determine whether a change made fo a system
has a statistically significant impact

Course Goals

O Use statistical tools to reduce the
number of simulations that need to be
performed of a computer system.

0 Design a set of experiments o obtain the
most information for a given level of
effort.




Course Goals

O Provide intuitive conceptual background
for some standard statistical tools.
Draw meaningful conclusions in presence of
noisy measurements.

Allow you to correctly and intelligently apply
techniques in new situations.

Course Goals

QO Present techniques for aggregating and
interpreting large quantities of data.
Obtain a big-picture view of your results.
Obtain new insights from complex measurement and
simulation results.
— E.g. How does a new feature impact the overall
system?




Agenda
Q Today

> Overview of course

» Performance metrics
o Characteristics of good metrics
o Standard processor and system metrics
o Speedup and relative change

Agenda (cont.)

0 Measurement tools and techniques
> Fundamental strategies
> Interval timers
» Cycle counters
» Program profiling
> Tracing
» Indirect measurement
> Measuring network delays and bandwidth




Agenda (cont.)

0 Simulation
» Types of simulations
» Random number generation
> Verification and validation

Agenda (cont.)

0 Statistical interpretation of measured
data
> Arithmetic, harmonic, geometric means
» Sources of measurement error
» Confidence intervals
» Statistically comparing alternatives




Agenda (cont.)

0 Design of experiments
> Terminology
» One-factor analysis of variance (ANOVA)
» Two-factor ANOVA
> Generalized m-factor experiments
» Fractional factorial designs
> Multi-factorial designs (Plackett and Berman)

Agenda (cont'd)

a Characterizing Measured Data
> Workload Characterization
> Fitting Measured Data to Known Distributions

o Q-Q plots
o Chi-square, K-S tests




Agenda (cont'd)

0 Simple analytical modeling
> Simple queuing models
o Single queue models
o Networks of queues
> Operational analysis
o Little's Law

Readings

0 Dror Feitelson, "Experimental Computer
Science: The need for a cultural change”
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Metrics

Performance metrics

0 What is a performance metric?

0 Characteristics of good metrics

0 Standard processor and system metrics
0 Speedup and relative change
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What is a performance metric?

Q Count

> Of how many times an event occurs
0 Duration

> Of a time interval
Q Size

> Of some parameter

O A value derived from these fundamental
measurements
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Time-normalized metrics

0 "Rate” metrics
> Normalize metric to common time basis
o Transactions per second
o Bytes per second
> (Number of events) = (time interval over which
events occurred)

0 "Throughput"

0 Useful for comparing measurements over
different time intervals
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What makes a "good” metric?

a Allows accurate and detailed comparisons
0 Leads to correct conclusions

0 Is well understood by everyone

0 Has a quantitative basis

0 A good meftric helps avoid erroneous
conclusions
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Good metrics are ...

dLinear
> Fits with our intuition

> If metric increases 2x, performance should
increase 2x

> Not an absolute requirement, but very appealing
o dB scale to measure sound is nonlinear
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Good metrics are ...

QO Reliable
> If metric A > metric B
o Then, Performance A > Performance B
> Seems obvious!
» However,
o MIPS(A) > MIPS(B), but
o Execution time (A) > Execution time (B)
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Good metrics are ...

0 Repeatable

> Same value is measured each time an
experiment is performed

> Must be deterministic
> Seems obvious, but not always true...

o E.g. Time-sharing changes measured execution

time
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Good metrics are ...

Q Easy to use
> No one will use it if it is hard o measure
> Hard to measure/derive
o — less likely to be measured correctly
> A wrong value is worse than a bad metric!
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Good metrics are ...

O Consistent

> Units and definition are constant across
systems

> Seems obvious, but often not true...
o E.g. MIPS, MFLOPS
> Inconsistent — impossible to make comparisons

30
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Good metrics are ...

0 Independent
> A lot of $$%$ riding on performance results

> Pressure on manufacturers to optimize for a
particular metric

> Pressure to influence definition of a metric

> But a good metric is independent of this
pressure

Good metrics are ...

Q Linear -- nice, but not necessary

0 Reliable -- required

0 Repeatable -- required

0 Easy to use -- nice, but not necessary
Q Consistent -- required

0 Independent -- required
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Clock rate

O Faster clock == higher performance
» 1G6Hz processor always better than 2 GHz
0 But is it a proportional increase?
O What about architectural differences?
> Actual operations performed per cycle
» Clocks per instruction (CPI)
> Penalty on branches due to pipeline depth

0 What if the processor is not the
bottleneck?

> Memory and I/0 delays

33

Clock rate

0 (Faster clock) _
Linear

# (better performance)

O A good first-order metric Reliable
Repeatable ©
Easy to
measure ©
Consistent ©
Independent ©
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MIPS

0 Measure of computation "speed”
Q Millions of instructions executed per
second

O MIPS=n/ (T, > 1000000)
> n = number of instructions
> T, = execution time
0 Physical analog
> Distance traveled per unit time
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MIPS
0 But how much actual .
. . . Linear
computation per instruction?
> Eg CISC VS. RISC Reliable
> Clocks per instruction (CPI)
QO MIPS = Meaningless Repeatable
Indicator of Performance
Easy to
measure
Consistent
Independent
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MFLOPS

0 Better definition of “distance traveled”
0 1 unit of computation (~distance) =1

floating-point operation

Q Millions of floating-point ops per second

O MFLOPS = f / (T, * 1000000)

> f = number of floating-point instructions

> T, = execution time

0 GFLOPS, TFLOPS,...
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MFLOPS

Q Integer program = 0
MFLOPS
» But still doing useful work
> Sorting, searching, etc.
O How to count a FLOP?
» E.g. franscendental ops, roots
0 Too much flexibility in
definition of a FLOP
O Not consistent across
machines

Linear

Reliable

Repeatable

Easy to
measure

Consistent

Independent

38

19



SPEC

(M

Suite

System Performance Evaluation Coop

Computer manufacturers select
“representative” programs for benchmark

O Standardized methodology

> Measure execution times

> Normalize to standard basis machine

» SPECmark = geometric mean of normalized

values
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SPEC

O Geometric mean is
inappropriate (more later)

O SPEC rating does not
correspond o execution
times of non-SPEC programs

O Subject to tinkering
» Committee determines which
programs should be part of the
suite
» Targeted compiler
optimizations

Linear

Reliable

Repeatable ©
mere | 3O
Consistent ©
Independent
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Execution time

0 Ultimately interested in time required fo
execute your program

0 Smallest total execution time == highest
performance

0 Compare times directly
0 Derive appropriate rates

Q Time == fundamental metric of
performance

> If you can't measure time, you don't know
anything
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Execution time

0 "Stopwatch” measured execution time
Start_count = read_timer();
Portion of program to be measured
Stop_count = read_timer();
Elapsed_time = (stop_count — start_count)
* clock_period;
0 Measures “wall clock” time
> Includes I/0 waits, time-sharing, OS overhead,

0 "CPU time" -- include only processor time

42
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Execution time

O Best to report both wall
clock and CPU times

O Includes system noise
effects
» Background OS tasks
> Virtual to physical page
mapping
» Random cache mapping and
replacement

> Variable system load
0 Report both mean and
variance (more later)

Linear

Reliable

© O

Repeatable

2
©

Easy to
measure

Consistent

Independent

© 06

43

Performance metrics summary

Clock | MIPS | MFLOPS | SPEC TIME
Linear ©
Reliable M ®)
Repeatable © © © © ©
Easy to
measure © | © © | :0 | ©
Consistent © © ©
Independent | © © ©
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Other metrics

0 Response time
> Elapsed time from request to response
Q Throughput
» Jobs, operations completed per unit time
> E.g. video frames per second
0 Bandwidth
> Bits per second
0 Ad hoc metrics
> Defined for a specific need
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Means vs. ends metrics

0 Means-based metrics
> Measure what was done
> Whether or not it was useful!
o Nop instructions, multiply by zero, ...
> Produces unreliable metrics
0 Ends-based metrics
> Measures progress towards a goal
> Only counts what is actually accomplished

46
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Means vs. ends metrics

Means-based Ends-based

Clock rate
MIPS
MFLOPS
SPEC
Execution time
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Speedup

0 Speedup of System 1 w.r.t System 2
> S,q8uch that: R, = S, R;
> Ry = "speed” of System 1
> R, = "speed” of System 2
Q System 2 is S, times faster than System
1

48
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Speedup

0 "Speed” is a rate metric
> Ri=D;/ T,
» D; ~ “distance traveled” by System i

0 Run the same benchmark program on both
systems
> —>D;=D,=D

O Total work done by each system is defined
to be "execution of the same program”
> Independent of architectural differences
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Speedup

R, _D,/T, DIT,
D,/T DIT,

S21

5

3|
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Speedup

§,, >1=>System 2 is faster than System 1

§,, <1=>System 2 is slower than System 1
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Relative change

0 Performance of System 2 relative to
System 1 as percent change

52
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Relative change

"R -R DIT,-DIT,
R, DIT,

AZ,I
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Relative change

A, >0=>System 2 is faster than System 1

A,, < 0= System 2is slower than System 1

54
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Important Points

O Metrics can be
» Counts
> Durations
> Sizes
> Some combination of the above
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Important Points

a6

>

ood metrics are

Linear

o More "natural”

Reliable

o Useful for comparison and prediction
Repeatable

Easy to use

Consistent

o Definition is the same across different systems
Independent of outside influences
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